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Micro Focus COBOL Server 2.3 Update 1
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

COBOL Server provides the execution environment for applications created with any IDE variant of Visual
COBOL.
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What's New
This release provides enhancements in the following areas:

• Application Server JCA support for Enterprise Server
• Data File Tools
• Database Access - OpenESQL
• File Handling
• UNIX and Linux platform support

Application Server JCA support for Enterprise Server

Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

This release provides support for automatic connection recovery to an active Java application server when
an enterprise server region is restarted. This applies to COBOL resource adapters.

Data File Tools

Back to Top

This release provides improved security and increased support for more file types. Features include:

• Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

• When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

• Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Database Access - OpenESQL

Back to Top

This release provides the following new features:

• Support for the Oracle fully managed ODP.NET driver.

File Handling

Back to Top

The following enhancements have been made to file handling processes:

• A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.

• Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.
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UNIX and Linux platform support

Back to Top

This release is now supported on SUSE and Red Hat platforms that are running the little-endian
PowerLinux architecture.

Note: These are 64-bit platforms only.

There are a few restrictions when running in this environment:

• The cob flag -p, which enables profiling, is not supported on Red Hat platforms.
• The cobmode utility is not supported.
• SQL functionality is restricted to OpenESQL support (ODBC and JDBC) only.
• The RM File Manager (RMFM) is not supported.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Run-Time System
• SQL: OpenESQL

Run-Time System

Back to the list

• The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.

If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:

mfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)
• Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE

class condition tests:

• IS [NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

• IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.
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• IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.

When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL

Back to the list

• The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

• Run a DSN bind against the customer database. Or:
• Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss

\InstallDigitsFunction.sql script.

This is a one-time only change to the database.

2843818 (1102248)
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Linking

• Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Common Communications Interface
• Communications Server
• Documentation
• Enterprise Server
• File Handling
• Micro Focus Common Client
• Micro Focus Directory Server
• Monitoring and Management
• Run-Time System
• SQL: OpenESQL
• XML Support

Adis

Back to the list

• Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.

2848637 (1102857)

Common Communications Interface

Back to the list

• The performance of Fileshare servers on Linux and UNIX platforms has been substantially improved
since the 2.2 Update 2 and 2.3 releases of Visual COBOL and Enterprise Developer.

2829622 (1101067)
• On UNIX, the product previously was looking for the cciusers.dat file (used for the initial population of

the MFDS Internal Security users and groups) in the /etc/ folder. Starting with this release, the
cciusers.dat file in $COBDIR/etc/ is used in preference. This removes the requirement to store
cciusers.dat in the /etc directory.

• Components that use the SSL/TLS support in CCI, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server

Back to the list

• The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.

2847439 (1102743)

Documentation

Back to the list
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• The instructions in the product help on how to run .NET COBOL applications from a network server
have been updated. These now include details about how to make the appropriate .NET run-time
assemblies available to your applications and how to elevate the security permissions levels of the
applications.

2826751 (1100478)
• When handling XML files, after a successful WRITE action, the size of the XML file written is returned

as the status code.

2587541 (1085484)
• When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This

switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.

• An Enterprise Server error message has been added to the help pages for CASKC0048, process soft-
killed failed and was hard-killed.

2846350 (1102574)
• The ldpli topics have been updated to include information about native ld options.

2840325 (1101829)
• The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.

2836105 (1101281)

• The "mfsupport" utility is now correctly named and spelled as MFSupportInfo, for Windows platforms.

2848869 (1102896)
• In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been

changed from 48 to 60.

2844479 (1102300)
• The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.

2844210 (1102719)
• Additional information added to the help pages for the audit event codes emitted by the External

Security Facility (ESF) and Micro Focus Directory Server (MFDS).

2842807 (1102120)
• If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using

a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true' or 'false'.

2837405 (1101440)

• Option D(o) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.

2839572 (1101835)

Enterprise Server

Back to the list

• The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.

2847684 (1103145)
• When processing a WSBIND that contain nested occurs levels, the group level is now correctly

maintained.
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2844738 (1102697)
• XA transactions will now end when an ECI request fails with PGMIDERR.

2843668 (1102276)
• The order in which user privileges are checked when accessing cataloged files has changed. First, a

check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.

2842162 (1102048)
• Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an

abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.

2841974 (1102004)
• When the targetService option was enabled for the JMS Invoke Webservice, no response was returned

to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI0112.

2841602 (1101959)
• casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get

deleted when using Delete from the ESMAC page.

2839657 (1101706)
• A Run-Time System error 114 no longer occurs when a GET request is received.

2825851 (1100157)
• You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already

using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.

2821228 (1099658)
• You no longer receive a memory leak in cassi processes when using the Micro Focus External Call

Interface.

• If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.

2836688 (1101388)

• The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly
matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").

2854402 (1103604)
• When using LDAP-based security immediately after installing Enterprise Server, with the sample access

rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.

2838380 (1101547)
• The LISTREFERENCES command now works correctly when the resource class names use special

characters.

File Handling

Back to the list

• OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.

2849233 (1102953)
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• If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified
at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.

2842825 (1102218)
• Rebuild now correctly processes the key structure defined through an options file.

2837028 (1101412)
• Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg

configuration file (e.g. [file.dat]).

2832386 (1100932)

• Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /k).

2837756 (615857)
• Rebuild now allows the case where "9" is specified after ":"

2836782 (1101437)

Micro Focus Common Client

Back to the list

• COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server

Back to the list

• Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

2846804 (1102971)
• Enterprise Server instance startup performance has been improved, particularly when the Enterprise

Server Administration GUI has been configured to use SSL.

2837359 (1101501)
• Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if

configured to use an SSL browser connection.

2834446 (1101342)
• The Enterprise Server user id no longer needs to have security administration access permissions to

start an Enterprise Server instance if external security is specified.

Monitoring and Management

Back to the list

• The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .

2830110 (1100895)

Run-Time System

Back to the list

• In the JVM COBOL run time, an alphanumeric comparison with a collating sequence now gives correct
results for character values greater than 127.

2839717 (1101845)
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• If a file is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.

2837230 (1101419)
• 64-bit Windows only, and native generated code only. Programs containing code of the form 01 f

comp-2. compute f = f ** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".

2836893 (1101465)
• When using "mfauditadm -r" on an audit file containing processes that have very long command lines,

the process could terminate early with a memory fault. This has now been resolved.

2832770 (1101000)
• The Sharedmem demo has been updated to make it compatible across all supported UNIX platforms.

Previously, on some platforms the semaphore synchronization did not work.
• Repeatedly calling and cancelling different programs in different threads could cause the application to

hang. This has now been resolved.

• In the .NET runtime, a managed executable can now be successfully executed using
CBL_EXEC_RUN_UNIT when an explicit .exe extension is specified in the program name.

2845604 (1102669)
• A new library routine, PC_PRINTER_INFO_DOTNET, is now available for .NET COBOL applications. It

enables the access to the .NET Graphics/PageSettings objects.

2845991 (1102545)
• .NET COBOL applications can now use PC_PRINTER_LOAD_BMP more than once without this

causing unexpected exceptions.

2845991 (1102546)
• Applications that use run units created with the MicroFocus.COBOL.RuntimeServices class could leak

memory.

2838583 (1101639)
• The XML I-O preprocessor no longer incorrectly represents some fixed point values in floating point

format.

2837561 (1101473)

SQL: OpenESQL

Back to the list

• An overflow problem with host variables of type System.Decimal has been fixed.

2849939 (1103195)
• OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC

in a managed application.

2847268 (1102968)
• A problem with EXEC ADO REBIND CONNECTION has been fixed.

2846426 (1102645)
• In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables

defined with zero (0) length.

2845409 (1102510)
• HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for

SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

2844292 (1102483)
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• HCOSS did not fully support DB2 ROW_NUMBER().

2843937 (1102362)
• Using SQL(CHECK) with .NET applications caused an error on Oracle.

2842102 (1102037)
• The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column

where the field is zero length.

2841149 (1102637)
• The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on

the COBSQLTYPE options list.

2840953 (1101877)
• An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL

errors.

2837717 (1101484)
• HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)

columns.

2832384 (1101169)
• The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when

SQL(ISOLATION) was set.

2797208 (1096456)

• To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.

2850022 (1103058)
• To correct a problem with closing CURSORs, SQL(SPCALLLOCAL) can now be used to instruct

OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.

2848402 (1102838)
• When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement

prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).

2847791 (1102782)
• OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL

Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.

2846825 (1102701)
• When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that

included literals containing angle bracket characters has been corrected.

2846226 (1102582)
• A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not

parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

2844399 (1102329)
• The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously

omitted from the drop-down list in the user interface.
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2842879 (1102128)
• When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error

occurred when the same cursor was opened and closed multiple times.

2841857 (1102003)
• The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length

input host variables that used an explicit-length field.

2841721 (1102106)
• A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has

been fixed.

2841508 (616495)
• When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with

embedded spaces.

2839826 (1101752)
• In European locales, Oracle queries failed to return the decimal symbol for floating point results

returned to decimal numeric host variables.

2839066 (1102162)
• OpenESQL SAVEPOINT handling was not working as expected with Static SQL.

2838227 (1101571)
• An HCOSS stored procedure called from multiple locations in either the calling application or in a

nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.

2834386 (1101104)
• HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a

stored procedure name in a host variable.

2833755 (1101022)
• OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned

values now correctly represent a 24-hour clock.

2833683 (1101017)
• The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.

2829499 (1102075)
• When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect

TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.

2823577 (1099922)
• The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X

host variables with CHAR and VARCHAR columns.

2806980 (1097582)
• An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now

returns errors rather than warnings. HCOSS is not supported in Visual COBOL.
• OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition

to the original partially managed provider. Note: The two providers are not 100% compatible. The
partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

XML Support

Back to the list

• PREXML now terminates and returns an error message if there is a problem expanding a copybook.

2472213 (1076394)
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• XMLPARSE did not honor the encoding in the XML declaration for output text.

2851343 (1103239)
• XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document

contains an XML declaration.

2837110 (1101424)
• XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.

2822339 (1099692)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2266906 (1066314)
• 2541594 (1081441)
• 2610077 (1087571)
• 2613606 (1088533)
• 2691674 (1093498)
• 2784725 (1095083)
• 2792882 (1102055)
• 2801626 (1097006)
• 2801847 (1097374)
• 2805056 (1097357)
• 2806566 (1097816)
• 2807649 (1097763)
• 2809132 (1097892)
• 2812331 (1098359)
• 2815582 (1099634)
• 2817630 (1101066)
• 2824712 (1100086)
• 2824925 (1099961)
• 2825098 (1100032)
• 2825249 (1101374)
• 2827707 (1100302)
• 2828305 (1100419)
• 2828897 (1100491)
• 2829677 (1100588)
• 2830741 (1100655)
• 2830871 (1100785)
• 2831477 (1100831)
• 2831788 (1100810)
• 2831959 (1100864)
• 2832490 (1100907)
• 2832904 (1100916)
• 2833083 (1101060)
• 2833100 (1101123)

• 2833473 (1101007)
• 2833925 (1101045)
• 2834217 (1101124)
• 2834245 (1101085)
• 2834253 (1101099)
• 2834843 (1101156)
• 2834959 (1101167)
• 2835289 (1101498)
• 2835416 (1101496)
• 2835506 (1101288)
• 2835508 (1101292)
• 2835599 (1101293)
• 2835608 (1101494)
• 2835687 (1101497)
• 2835835 (1101262)
• 2836694 (1101356)
• 2837531 (1101490)
• 2837784 (1101511)
• 2838086 (1101525)
• 2838343 (1101586)
• 2838426 (1101552)
• 2838593 (1101986)
• 2838671 (1101587)
• 2838689 (1102052)
• 2839730 (1101776)
• 2840155 (1101821)
• 2840349 (1101906)
• 2840530 (1101860)
• 2840658 (1101893)
• 2840766 (1101857)
• 2840977 (1102019)
• 2841607 (1101961)
• 2841785 (1101988)

• 2841933 (1102021)
• 2842318 (1102129)
• 2842702 (1102121)
• 2842940 (1102122)
• 2843048 (1102186)
• 2843076 (1102135)
• 2843140 (1102509)
• 2843301 (1102185)
• 2843324 (1102296)
• 2843438 (1102240)
• 2843446 (1102173)
• 2843446 (1102174)
• 2843884 (1102492)
• 2845184 (1102627)
• 2845218 (1102490)
• 2845635 (1102601)
• 2845781 (1102730)
• 2846150 (1102557)
• 2846669 (1102644)
• 2846797 (1102780)
• 2846971 (1103070)
• 2847253 (1102806)
• 2847876 (1102765)
• 2848324 (1103143)
• 2849271 (1103044)
• 2849307 (1102974)
• 2849430 (1103011)
• 2849508 (1102970)
• 2849972 (1103094)
• 2851114 (1103175)
• 2851169 (1103174)
• 2852143 (1103362)
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Installation

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements

Hardware Requirements

The disk space requirements are approximately:

COBOL Server Sentinel RMS License Manager

525MB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note:

• The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

• This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.
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Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in COBOL Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements

To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.

Click here to see this information on the Micro Focus Infocenter.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
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• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.

On UNIX

System Requirements

Hardware Requirements

The disk space requirements are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER
running AIX

Micro Focus installer 353 1.41 GB 706 36.5
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

HP IA Micro Focus installer 685 2.74 GB 1370 69

System Z
running Red Hat
Linux

Micro Focus installer 284 1.14 GB 568 36

x86-64 running
Red Hat Linux

Micro Focus installer 298 1.19 GB 596 46

SPARC running
Solaris

Micro Focus installer 342 1.37 GB 684 40

x86-64 running
Solaris

Micro Focus installer 313 1.25 GB 626 31

System Z
running SUSE
SLES

Micro Focus installer 287 1.15 GB 574 36

x86-64 running
SUSE SLES

Micro Focus installer 302 1.21 GB 604 46

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note: This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

• On IBM System z (390), you must have the following operating system libraries installed:

glibc-*.s390
glibc-*.s390x
libgcc-*.s390
libgcc-*.s390x

Visit the Red Hat Web site for more information.
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• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required for native COBOL and Java
interoperability. The setup file installs Java 8 u51 32-bit. You can download Oracle's Java EE from 
Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.

Click here to see this information on the Micro Focus Infocenter.

UNIX and Linux Installer Issues

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.
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Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks.

Installing on Windows
Note: If there is an earlier version of COBOL Server installed on your machine, check Installing as an
Upgrade first.

These are the steps to install this product:

1. Run the cs_231.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in Software Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_cobol_server_2.3_update1_platform

2. Run the installer with superuser permissions:

./setup_cobol_server_2.3_update1_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.
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The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_cobol_server_2.3_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade
• Command line installation options

Click here to see this information on the Micro Focus Infocenter.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

COBOL Server Installation Options
To install COBOL Server you run cs_231.exe which contains a number of product .msi files (Windows
Installer packages). When run, cs_231.exe performs some initial system checks then sequentially installs
the .msi files.

cs_231.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
cs_231.exe

Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.
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• Non-interactive Installation

Format:
cs_231.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
cs_231.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
cs_231.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: cs_231.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Micro Focus Infocenter.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:
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1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

COBOL Server installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./ -installlocation="full path of new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
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-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.f

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows
To access the COBOL Server help:

• On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus COBOL Server >
Documentation from the Windows Taskbar.

• On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the COBOL Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Micro Focus
Developer > Micro Focus COBOL Server.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
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2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.

3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.

4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

On UNIX

Setting the Environment
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_COBOLServer2.3.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
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Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
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• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
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6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.
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